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Diplomová práca musí mať dobrú úroveň hlavne po stránke odbornej, 
má mať aj náležitú formálnu úpravu a primeraný rozsah. 

Treba si uvedomiť, že diplomovú prácu podrobne čítajú len dvaja ľudia –
vedúci diplomovej práce a oponent. 

Ostatní členovia komisie v priebehu niekoľko desiatok minút počas obhajoby
si prácu (len) prelistujú a spravidla prečítajú

úvod, záver, resp. vybraté pasáže diplomovej práce. 

Čo však stihnú aj v takom krátkom časovom intervale posúdiť, 
to je formálna stránka diplomovej práce.

Z uvedeného vyplýva, že 
formálnej stránke spracovania diplomovej práce treba venovať náležitú

pozornosť.“
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Rozsah záverečných prác nie je predpísaný. 
Vnútorný predpis rektora UK (12/2013) ho len odporúča. 

Pri navrhovanom type a veľkosti písma, šírke nastavenia okrajov a 
riadkovania to predstavuje 30 až 50 strán (90 až 126 tisíc úderov) pre 

diplomové práce. 

Do tohto rozsahu sa počíta len hlavná textová časť
(od úvodu až po zoznam použitej literatúry), 

bez úvodnej časti a príloh. 

Primeranosť rozsahu záverečnej práce 
však v konečnom dôsledku posúdi vedúci práce, 

pretože oveľa dôležitejšia je úroveň a kvalita práce než jej rozsah. 
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Akým spôsobom treba písať záverečnú prácu? 

Na to neexistuje žiadne jednotné pravidlo. 

Prácu možno písať:

v prvej osobe množného čísla („pokusy sme robili na“) 

v prvej osobe jednotného čísla („pokusy som robil na“), 

v trpnom rode („pokusy boli robené na“), 

neosobne používajúc zvratné zámená („pokusy sa robili na“)  

v tretej osobe jednotného čísla („autor robil pokusy na“). 
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Ak sa vyjadrujeme v prvej osobe množného čísla, môže to vyvolať dojem, 
že ide o autorstvo viacerých osôb, 

prípadne že ide o tzv. majestátny plurál (pluralis maiestaticus), 
niektorými autormi považovaný za nenáležitý, 

(s poznámkou, že ho môžu požívať len monarchovia, vydavatelia a tehotné ženy). 

Voči používaniu prvej osoby jednotného čísla sa zvykne namietať, 
že je to neskromné, že si to môžu dovoliť nanajvýš vedecké autority. 

Na druhej strane panuje názor, že ak pisateľ sám seba vo vedeckom texte 
označuje prvou osobou množného čísla, ide o 

tzv. autorský plurál (pluralis auctoris), 
resp. plurál skromnosti (pluralis modestiae), 

ktorým naznačuje, že čerpal vedomosti aj z diel svojich predchodcov. 

V súčasnosti však viacerí vysokoškolskí pedagógovia zastávajú stanovisko, 
že autor by mal písať prácu v prvej osobe jednotného čísla aby zdôraznil, 

že prácu vypracoval samostatne vlastnou tvorivou činnosťou. 

Otázkou je tiež v akom čase treba prácu napísať. 
Niektoré kapitoly možno napísať v minulom (napr. metódy), 

iné zasa v prítomnom čase (napr. diskusiu). 
Treba ale dbať na to, aby sme osobu, číslo a čas nemenili pričasto. Karol HENSELKarol HENSELKarol HENSEL



Niekoľko prospešných ponaučení: 

Záverečné práce píšeme v textovom editore (napr. MS Office Word) 
tlačíme iba na jednej strane bieleho nepriehľadného papiera

formátu A4 (210 × 297 mm) orientovaného na výšku. 
Farebný papier by sa používať nemal, ani na prílohy. 

Úpravu obalu, titulného listu a nasledujúcich strán 
urobíme podľa príloh 1 až 4. 

Okraje na stránke nastavíme pomocou príkazov 
[Súbor → Vzhľad stránky → Okraje (File → Page Setup → Margins)] 

takto: ľavý na 3 cm, vrchný, spodný a pravý na 2,5 cm. 
Riadkovanie nastavíme na hodnotu 1,5.

Karol HENSELKarol HENSELKarol HENSEL



Odporúčame použiť serifové (pätkové) písmo v základom reze 
o veľkosti 12 bodov (tzv. cicero). 

Napríklad: 
»Times New Roman«, »Palatino linotype«, »Century«, 

»Georgia«, »Garamond«, »Book Antiqua« a pod.

Pre poznámky pod čiarou používame veľkosť 10 bodov (tzv. garmond). 

Bezserifové písmo používame pri písaní tabuliek a popisovaní obrázkov. 
Napríklad: »Arial«, »Albertus Medium«, »Antique Olive«, »Century

Gothic«, »Tahoma«, »Univers«, »Verdana« a pod.

Takýmto písmom môžeme písať aj nadpisy kapitol a odsekov 
jeho veľkosť stupňujeme v porovnaním so základným textom 

vždy o 2 body vyššie. 
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Strany hlavného textu číslujeme v strede spodného okraja 
arabskými číslicami rovnakého typu akým je napísaný text. 

Titulná strana diplomovej práce číslo nenesie, 
nasledujúca strana má číslo 2. 

Na číslovanie strán použijeme ponuku
automatického číslovania strán textového procesora. 

Kapitoly a ich časti označujeme priebežne arabskými číslicami. 
Číslujeme vzostupne od jednotky podľa zásad desatinného triedenia. 

Odporúčame použiťmaximálne tri úrovne členenia. 

Ak za číslicami nasleduje výraz alebo veta, píšeme na konci bodku. 
Napríklad: 2.3. Štatistické metódy.

Úvod, záver a zoznam literatúry sa nečíslujú. 

Je veľmi výhodné využiť ponuku automatického číslovania odsekov, 
pretože pri akomkoľvek preskupení ich počítač prečísluje automaticky.
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Členenie textu robíme tak, že 
prvý riadok každého odseku, tzv. zarážkový riadok, 

odrazíme o štvrť (0,64 cm) alebo pol palca (1,27 cm) doprava, 
prinajmenšom však o šírku typografického štvorčeka, 

ktorý pri písme o 12 bodoch meria 0,45 cm. 

Používame na to formátovanie odseku 
[Formát → Odsek → Zarážky a medzery → Zarážky –

Špeciálne: prvý riadok– O koľko: 0,64 cm; 
(Format → Paragraph → Indents and Spacing → Indentation –

Special: first line – By: 0,64 cm)]. 
Pri formátovaní odseku Zoznam literatúry namiesto „prvý riadok“

označíme výraz „opakovaná zarážka“[hanging]. 

Prvý riadok odseku, tzv. zarážkový riadok, 
nemôže zostať osamotený na konci strany 

a podobne posledný, tzv. východový riadok odseku, 
sa nemôže v žiadnom prípade ocitnúť na začiatku strany 

(v typografickom žargóne sa takýmto osamoteným riadkom hovorí
„vdovy“ a „siroty“). 

Aby sme sa tomuto vyhli, používame formátovanie odseku 
[Formát → Odsek → Zlomy riadkov a strán – kontrola osamotených riadkov 

(Format → Paragraph → Line and Page break – Widow/Orphan Control)]. Karol HENSELKarol HENSELKarol HENSEL



Ľavý i pravý okraj textu práce zarovnávame do bloku. 
V takomto prípade sa môžu medzi slovami objaviť veľké nevzhľadné

medzery, ktoré typografi nazývajú „riekami“. 
Dajú sa síce odstrániťmechanickým rozdelením slova spojovníkom, 

je to však nepatričný spôsob, pretože pri akomkoľvek posune textu spojovník 
z daného slova nezmizne, 

ale celé slovo sa jednoducho presunie aj so vpísaným spojovníkom do riadku. 
To je hrubá chyba. 

Preto je veľmi výhodné, ak si vopred nastavíme automatické delenie slov. 
Urobíme to v dvoch krokoch. Najprv si v ponuke 

Nástroje (Tools) 
zvolíme jazyk [Nástroje → Jazyk → Slovenčina 

(Tools → Language → Slovak)]
a potom delenie slov

[Nástroje → Jazyk → Delenie slov → Deliť slová automaticky 
(Tools → Languages → Hyphenation → Automatically hyphenate

document)]. 

Zároveň si tam nastavíme aj počet riadkov s rozdelenými slovami pod sebou. 
Podľa typografických pravidiel môžu byť najviac tri. 

Pri automatickom delení slov sa spojovník objavuje len na konci riadku 
a pri presune slova na iné miesto zmizne. Karol HENSELKarol HENSELKarol HENSEL



Interpunkčné znamienka

bodka, čiarka, bodkočiarka, dvojbodka, 
tri bodky, otáznik, výkričník, apostrof

píšeme bez medzery za predchádzajúcim slovom; medzeru vynechávame 
až za nimi. 

Ak bodku použijeme ako znamienko pre násobenie, 
medzeru nerobíme pred ňou ani po nej. 

Ako znamienko násobenia však používajme 
bodku situovanú v strede kužeľky

(teda nie g.l ale g·l). 

Obdobne to platí aj pre desatinné čiarky
a znamienka na odčlenenie hodín a minút. 
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Pomlčku (–) píšeme s medzerami, 
spojovník (-) bez medzier. 

Pri písaní rozsahu strán pred ani za pomlčkou medzeru nerobíme. 
Nikdy nepíšme namiesto pomlčky spojovník! 

Napríklad: 
V termíne 1. 9. – 15. 10. 2012; pp. 48–59; anglicko-slovenský slovník. 

Pomlčku používame aj ako znak pre odčítanie, 
alebo na označenie záporných čísiel. 

Znamienko mínus má dĺžku pomlčky ale píše sa vyššie (nie -3 ale −3). 
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Úvodzovky a zátvorky

píšeme bez medzier pred aj za výrazom, ktorý je medzi nimi. 
Môžeme používať rôzne typy 
úvodzoviek „“ – ‚‘ – »«
alebo zátvoriek (�) – [�] – {�}. 

Nikdy nepoužívajme 
“anglické”, „poľské” alebo ”švédske” úvodzovky namiesto „slovenských“,

ani lomky /�/ namiesto zátvoriek. 

Čísla, ktoré majú viac ako tri miesta 
naľavo alebo napravo od desatinnej čiarky, 

môžeme oddeľovaťmedzerou vždy po troch miestach. 
Pri písaní letopočtu však medzeru nerobíme. 

Napríklad: 
π = 3,141 592 653…; cena 12 350,50 €; 20. 10. 2012. 

Niektoré čísla, dajme tomu telefónne, môžeme členiť aj iným spôsobom. 
Napríklad: 

tel. (02) 60 29 62 49. 

66
99 
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Citácie a bibliografické odkazy


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Citácie a bibliografické odkazy
Citácia alebo citovanie

= skrátené označenie zdroja (dokumentu) v texte práce. 

Záznam o citovanom dokumente
= položka v abecedne usporiadanom 
zozname bibliografických odkazov 

(v kapitole nazvanej „Zoznam použitej literatúry“). 

Citát
= doslovne uvedený výrok z citovaného dokumentu. 

Uvádza sa vždy v úvodzovkách. 

Parafráza
= voľné tlmočenie cudzích myšlienok 

alebo obsahu pôvodného diela (riadne sa cituje). 
Parafrázujeme tiež amatérske preklady cudzojazyčnej 

literatúry, ktorú používame vo svojich prácach. 
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Etika citovania a plagiátorstvo

Etika citovania
= dodržiavanie etických noriem vo vzťahu k cudzím 

myšlienkam a výsledkom, ktoré sú obsiahnuté v použitej 
literatúre. 

Záverečná práca nesmie mať charakter plagiátorstva, 
nesmie narúšať autorské práva iných autorov. 

Treba dôsledne citovať použité informačné zdroje, 
presne opísať použité metódy, pracovné postupy 

a výsledky výskumu iných autorov.

Plagiátorstvom nie je len úmyselné okopírovanie 
(ukradnutie) cudzieho textu a jeho vydávanie za vlastný, 

ale aj nedbalé citovanie, 
neúmyselné opomenutie citácie využitého zdroja
či nedostatočná práca s pôvodným textom 

(nedostatočná parafráza).Karol HENSELKarol HENSELKarol HENSEL



Zoznam literatúry môže obsahovať len také pramene 
(bibliografické odkazy), ktoré sú citované v texte. 

V žiadnom prípade nesmie byť súpisom literatúry 
týkajúcej sa danej témy. 

V texte práce sa môžeme odvolávať len na pramene 
uvedené v zozname literatúry. 

Výnimkou sú informácie získané ústnou, alebo písomnou
formou. Tie sa citujú iba v texte. 

Priezvisko osoby, ktorá informáciu poskytla, 
sa uvádza aj s iniciálovou skratkou mena 

s poznámkou in verb. (pri slovnej informácii) 
alebo in litt. (pri písomnej informácii). 

Napríklad: 
O. Ferianc (in verb.) prípadne (O. Ferianc in verb.), 

alebo I. Zmoray (in litt.) prípadne (I. Zmoray in litt.).
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Na bibliografický záznam uvedený v zozname literatúry sa v 
texte práce odvolávame nasledovným spôsobom: 

Brtek (1963, 1968) alebo (Brtek 1963, 1968)
– ak má práca jedného autora; 

Štepanovičová a Beláková (1965) alebo (Štepanovičová a 
Beláková 1965)

– ak má práca dvoch autorov; 

Mann et al. (1902) alebo (Mann et al. 1902) 
– ak má práca viac ako dvoch autorov. 

Ak citujeme práce viacerých autorov za sebou, zoraďujeme 
ich v chronologickom poradí. 

(Mann et al. 1902, Brtek 1963, 1968, Štepanovičová & Beláková
1965).
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Ak citujeme dokument, ktorý nepoznáme v origináli 
ale iba sprostredkovane, 

uvádzajme zdroj v zozname literatúry 
za daným bibliografickým odkazom v hranatých zátvorkách. 

Napr. [Citované podľa Berga (1912).]

Citovaniu „z druhej ruky“ by sme sa však mali vyhýbať, 
pretože takto získané informácie môžu byť nepresné alebo 

skreslené. 
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Publikácie citované v texte sa v zozname literatúry uvádzajú
v abecednom poradí podľa priezvísk autorov. 

Viaceré publikácie toho istého autora (tých istých spoluautorov) 
sa uvádzajú v chronologickom poradí, 
pričom samostatné práce daného autora 

majú prednosť pred jeho prácami v spoluautorstve. 

Ak sú práce určitého autora publikované v rovnakom roku, treba 
ich rozlíšiť pripísaním malého písmena (a – z) k roku vydania. 

Príklady: 
Nový T. 1994. 
Nový T. 2001a. 
Nový T. 2001b. 
Nový T. & Abel F. 1975. 
Nový T. & Getrová J. 1968. 
Nový T., Getrová J. & Mucha K. 1962. 
Nový T., Getrová J., Mucha K. & Weiss L. 1956. 
Nový T. & Marko M. 1967. 
Nový Z. 1955. Karol HENSELKarol HENSELKarol HENSEL



Priezviská autorov, názvy publikácií, periodík, vydavateľstiev 
alebo miest vydania sa uvádzajú v pôvodnom znení. 

Výnimku tvoria práce, ktoré sú napísané v iných grafických 
sústavách; tie sa musia prepísať do latinského písma. 

Pri citovaní kníh sa treba riadiť údajmi uvedenými na titulnom 
liste a nie na obálke alebo papierovom prebale. 

Názvy publikácií sa uvádzajú v neskrátenej podobe. 
Možno však skracovať názvy časopisov, nie ľubovoľne, 

ale podľa pravidiel, ktoré sú uvedené v príslušných normách.

Zvláštne výtlačky článkov vedeckých časopisov, 
tzv. separáty (Sonderdrucke, tirés à part, reprints), 

sa tlačili kedysi osobitne 
a ich stránky sa niekedy číslovali od jednotky. 
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Techniku citovania a uvádzania bibliografických odkazov 
predpisujú rôzne národné i medzinárodné normy. 

Na Slovensku sú to STN ISO 690 (1998) a STN ISO 690-2 (2001). 

Riadi sa však aj zvyklosťami daných vedných oblastí, 
je určovaná redakčnými smernicami vedeckých časopisov rôzne. 

Bibliografické odkazy nemôžeme z publikácií opisovať
mechanicky, musíme ich v zozname literatúry upraviť do 

jednotnej podoby. 

Na základe porovnania spôsobov zápisu bibliografických 
odkazov v 50 medzinárodných karentovaných časopisoch

z oblasti zoológie a príbuzných vied odporúčame nasledovnú
techniku citovania: 
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Bibliografický odkaz na monografickú publikáciu

Abe T. 1978. Genshoku gyorui kensaku zukan. Kaitei 7 ban hakkō.
[Obrázková kniha na určovanie rýb v pôvodných farbách. 
7. upr. vydanie.] Hokuryukan, Tōkyō. 359 pp. (V japončine.) 

Lagler K.F., Bardach J.E., Miller R.R. & May Pasino D.R. 1962.
Ichthyology. 2nd ed. John Wiley & Sons, New York. 506 pp. 

Szarski H. (ed.). 1978. Anatomia porównawcza kręgowców.
Państwowe wydawnictwo naukowe, Warszawa. 773 pp.

Ak je v prameni uvedených viac miest vydania, 
uvedie sa to, ktoré je typograficky zvýraznené. 

Ak sú názvy miest rovnako dôležité, uvedie sa prvé mesto. 
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Bibliografický odkaz na časťmonografickej publikácie 

Baruš V. & Oliva O. (ed.). 1992. Obojživelníci – Amphibia.
Fauna ČSFR, sv. 25. Academia, Praha. 338 pp. 

Berg L.S. 1949. Ryby presnych vod SSSR i sopredeľnych
stran. Časť 2. Izd. 4. Izdateľstvo Akademiji Nauk SSSR,
Moskva, pp. 467–925. 

Starck D. 1979. Vergleichende Anatomie der Wirbeltiere
auf evolutionsbiologischer Grundlage. Band 2: 
Das Skeletsystem.  Springer-Verlag, Berlin. xii+776 pp. 
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Bibliografický odkaz na príspevok (odsek, kapitolu) v 
monografii

Bartoš E. 1971. Želvušky – Tardigrada. In: Klíč zvířeny
ČSSR. Díl 4. Československá akademie věd, Praha, pp. 
7–9. 

Devillers C. 1965. Anatomie comparée. In: Grassé P.-P. 
& Devillers C. Précis de sciences biologiques. Zoologie II
Vertébrés. Masson &  Cie, Paris, pp. 9–439. 

Oliva O. & Hrabě S. 1968. Ryby – Pisces. In: Ferianc O. (ed.)
Stavovce  Slovenska I. Vydavateľstvo SAV, Bratislava, pp.
5–227. 
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Bibliografický odkaz na príspevok (článok, abstrakt) v 
zborníku 

Barciová T. & Hanzelová V. 2010. Kontaminanty v rybách 
a ich parazitoch. In: Zborník abstraktov z konferencie 16.
Feriancové dni 2010. Prírodovedecká fakulta UK, Bratis-
lava, p. 14. 

Dúbravská J., Gyarmathy E. & Debrecéni O. 2002. Správanie
kôz ustajnených v kozíne počas celé-ho dňa. In: Kováč V. 
& D. Némethová (ed.). Zborník abstraktov, Kongres slo-
venských zoológov, Smolenice 2002. Slovenská zoologická
spoločnosť, Bratislava, p. 48. 

Žitňan R. 1972. Doterajšie poznatky o ichtyofauně [sic!]
Dunaja pod  Komárnom. In: Peňáz M. & Prokeš M. 
Sborník referátů z ichtyologické konference, Brno, 16.–17.
3. 1972. Slovenská zoologická společnost při SAV Ichtyo-
logická sekce, Brno, pp. 76–79. 
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Bibliografický odkaz na článok v seriálovej publikácii 
(časopise) 

Byczkowska-Smyk W. 1964. Problem wymiany gazowej u ryb.
Prezegląd Zoologiczny 8 (4): 335-341. 

Vladykov V. 1952. Ueber einige neue Fische aus der Tschecho-
slowakei (Karpatorussland). Zoologischer Anzeiger 64 (11/12):
248–252. 

Oliva O. 1954. A revision of the cyprinid fishes of Czechoslovakia
with regard to their secondary sexual characters. Bull. Intern. 
de l’Acad. tchéque des Sciences 53 (1) 1952: 1-61, 2 pl. 
Zväzok 53. tohto periodika je označený rokom 1952, 
v skutočnosti bol publikovaný až v roku 1954!

___________

Ak sú jednotlivé čísla jedného zväzku (ročníka) seriálovej publi-
kácie paginované osobitne, potom je nutné v bibliografickom 
odkaze uviesť aj číslo. Odporúčame však písanie čísiel aj v prípa-
doch, ak je paginácia zväzku kontinuálna.Karol HENSELKarol HENSELKarol HENSEL



Bibliografický odkaz na normu

ISO 9. 1995. Information and documentation
– Transliteration of Cyrillic characters into Latin characters –
Slavic and non-Slavic languages. 

STN ISO 4 (01 0196). 2001. Informácie a dokumentácia.
Pravidlá skracovania slov z názvov a názvov dokumentov. 

STN ISO 690 (010197). 1998. Dokumentácia. Bibliografické
odkazy. Obsah, forma a štruktúra. 
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Bibliografický odkaz na záznam v referátovom časopise

Abolius L.1924. The influence of the maximal bowel-respiration
on the anatomy of the bowel of Misgurnus fossilis in: Arb.
vergl. anat. zool. Inst. Riga, Nr. 7. 1924 (Lettisch mit engli-
schem Summary.). In: Zoologischer Bericht 7 (9/11) 1925: 292. 

Burns K.J. 1993. Geographic variation of the fox sparrow.
Condor 95 (3): 652-661. In: Biological Abstract 96 (11): 1A-225,
ref. 1211023. 

Krychtin M.L. 1978. Nekotoryje fiziologo-biochemičeskije
pokazateli kalugi Huso dauricus (Geor-gi) limana Amura.
Vopr. ichtiologiji 18: 1088-1098. In: Referativnyj žurnal –
Biologija VINITI 1979 4: 26, ref. 4 C 157. 
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Pri citovaní patentových dokumentov sa namiesto autora 
uvádza názov organizácie vlastniacej práva. 

Citácia patentového dokumentu

Carl Zeiss Jena, VEB. Anordnung zur lichtelektrischen Erfas-
sung der Mitte eines Lichtenfeldes. Erfinder: W. Feist, C.
Wahnert, E. Feistauer. Int. Cl.3 G02 B 27/14. Schweiz Patent-
schrift, 608 626. 1979–01–15. 

Nová Huť, A.S., Ostrava. Trysková sestava přestupníkového
kolena. Původce vynálezu: Jiří Kose. Int Cl6 C 10 B 27/06.
Česká republika. Patentový spis 279967. 29. 12. 1990. 

Úrad priemyselného vlastníctva Slovenskej republiky: Spôsob
výroby tesnenia valivých ložísk. Majiteľ a pôvodca patentu:
Vladimír Lukáč, Jozef Hrehor, Oldřich Roučka. Int. Cl.
F16C33/76. Slovenská republika. Patentový spis, 278399.
05.03. 97. 
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Bibliografický odkaz na výskumnú správu

Adamková J. (ed.). 2002. Príprava databázy hydromorfolo-
gických a biologických ukazovateľov pre proces výberu 
a charakterizácie referenčných miest podľa Smernice
2000/60EC. Slovenský hydrometeorologický ústav,
Bratislava. 91 pp. 

Mišík V. 1960. Biometrika rodu Abramis. Záverečné správa
úlohy Ichtyologický prieskum Slovenska. Laboratórium
rybárstva a hydrobiológie, Bratislava. 187 pp. 

Sedlár J. & Stráňai I. 1975. Výskum ichtyofauny povodia
rieky Hron. Záverečná správa. Vysoká škola poľnohospo-

dárska, Nitra. 103 pp. 
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Bibliografický odkaz na recenziu bez zvláštneho názvu

Matoušek B. 1979. (rec.). Ponec, J., Mihálik, Š.: Prírodné
rezervácie na Slovensku. Vydalo Vydavateľstvo Osveta, n. p.
Martin roku 1977. Strán  240, 176 čiernobielych a 42 fareb-
ných fotografií. Cena 50,– Kčs. In: Acta Rer. natur. Mus. nat.
slov., Bratislava 25: 192–193. 

Novák V.J.A. 1990. (rec.). Lima-de-Faria A., 1989: Evolution
without selection (Form and function by autoevolution).
Elsevier, Amsterdam, 37A pp. In: Acta Soc. Zool. Bohemo-
slov. 54 (4): 319-320. 

________________

Recenzie so zvláštnym názvom 
citujeme obdobne ako články v seriálovej publikácii (časopise). 
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Bibliografický odkaz na 
bakalársku, diplomovú, dizertačnú, rigoróznu… prácu 

Harant R. 2006. Kraniálna osteológia plotice červenookej –
Rutilus rutilus a plotice lesklej – Rutilus pigus. Diplomová
práca. Katedra zoológie PriF UK, Bratislava. 72 pp., 35 fig.,
31 tab. 

Kováč V. 2000. Synchrónia a heterochrónia v ontogenéze rýb.
Habilitačná práca. Prírodovedecká fakulta UK, Bratislava.
195 pp. 

Pastuchová Z. 2008. Posúdenie vplyvu morfohydraulickej
štruktúry koryta malých tokov na osídlenie bentickými
bezstavovcami. Dizertačná práca. Ústav zoológie SAV,
Bratislava. 137 pp. 
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Bibliografický odkaz na elektronické dokumenty

Freyhof J. & Kottelat M. 2008. Hucho hucho. In: IUCN 2011. IUCN Red list 
of threatened species. Verzia 2011.2. [Cit. 09. 02. 2012]. Dostupné na
<http://www.iucnredlist.org/apps/redlist /details/10264/0> 

Pri dokumentoch, ktoré podliehajú zmenám alebo nie sú datované, 
treba v hranatých zátvorkách za skratkou Cit. uviesť dátum stiahnutia dokumentu

Jarial M.S. & Wilkins J.H. 2010. Structure of the kidney in the coelacanth
Latimeria chalumnae with reference to osmoregulation. Journal of Fish
Biology 76: 655–668. Dostupné na <DOI: 10.1111/j.1095-8649.2009.    
02522.x> 

V prípade, že ide o publikáciu inštitúcie, uvedieme ju ako autora: 
ISSN [International Standard Serial Number]. 2011. The list of title word
abbreviations. Dostupné na <http://www.issn.org/2-22661-LTWA-online.php> 
V prípade, že nie je uvedený autor, uvedieme začiatok názvu článku, (v prípade, že nie je možné dohľadať ani 
dátum zverejnenia, uvedie sa dátum stiahnutia). 
First Steps. 1996. First steps: A Manual for Starting human Rights Education.

1996. Electronic Re-source Centre for Human Rights Education. [Cit. 20. 06.
2008]. Dostupné na <http://www.hrea.org/erc/Library/First_Steps/index_
eng.html> 

Parasitic diseases. 2012. Parasitic diseases of fish. 2012. [Cit. 20. 02. 2012].
Dostupné na <http://ag.ansc.purdue.edu/courses/aq448/diseases/
parasites.htm>                                    Karol HENSELKarol HENSELKarol HENSEL



Názvy odborných časopisov a iných periodík

Názvy odborných časopisov a iných periodík 
treba uvádzať v rovnakom znení, aký je na titulnom liste. 

V prípade, že viacero časopisov nesie rovnaký názov, 
treba v zátvorke uviesťmiesto vydania; 

napr. Biologia (Bratislava). 

Názvy sa môžu uvádzať aj v skrátenej podobe, 
potom ale jednotne v celom zozname literatúry. 

Zásady skracovania a zoznam skratiek nájdeme 
v normách STN ISO 4 (2001) a ISSN (2011). 
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Transliterácia a transkripcia 
Do bibliografického odkazu zapisujeme údaje v jazyku citovanej 

publikácie. Výnimkou sú práce napísané v iných abecedách; 
tie musíme prepísať do latinky. 

Existujú dva spôsoby prepisu: transliterácia a transkripcia. 

Pri transliterácii sa každé písmeno jednej abecedy prepisuje 
písmenom druhej abecedy tak, aby pri spätnom prepise 
nevznikali diferencie. 
Pravidlá transliterácie slovanských jazykov, ktoré používajú
cyriliku, do latinského písma určuje norma ISO 9 (1995). 
Slovenská technická norma č. 010185 „Transliterácie cyriliky“ z 
roku 1975 je už neplatná. 

Pri transkripcii ide o prepis, ktorý najvernejšie zachytáva 
zvukovú podobu daného jazyka. Preto sa môže konkrétne 
písmeno prepisovať podľa toho, akú hlásku vo výslovnosti 
zastupuje. Bežný prepis (transkripciu) cyrilského písma do 
slovenčiny uvádzajú Pravidlá slovenského pravopisu. Karol HENSELKarol HENSELKarol HENSEL



Васильева Б.Ф. 1977. Экология хищных рыб южной части байкальского
бассейна. Вопросы ихтиологии 17 (4) 384—392. 

Vasil’eva B.F. 1977. Èkologiâ hiŝnyh ryb ûžnoj časti bajkal’skogo bassejna.
Voprosy ihtiologii 17 (4): 384–392. 

Vasilieva B.F. 1977. Ekologija chiščnych ryb južnoj časti bajkaľskogo
bassejna. Voprosy ichtiologiji 17 (4): 384–392. 

Ak je práca napísaná v inej grafickej sústave, uvádzam jej titul v prepise alebo (aj) v preklade [v hranatých 
zátvorkách] a na konci odkazu uvedieme v okrúhlych zátvorkách jazyk, v ktorom bola práca napísaná. 

Napríklad knihu: 
阿部宗明著鷲｡ 1978｡ 原色魚類検索図鑑｡ 攷訂7版発行｡ 北隆館､東京｡ 359 
ページ｡
možno citovať ako:
Abe T. 1978. Genshoku gyorui kensaku zukan. Kaitei 7 ban hakkō. 

[Obrázková kniha na určovanie rýb v pôvodných farbách. 7. upravené
vydanie.] Hokuryukan, Tōkyō. 359 pp. (V japončine.) 

Nie vždy však dokážeme transkribovať a preložiť pôvodný titul práce. Ak je v práci uvedený 
názov aj v inom jazyku (napríklad v angličtine), uvedieme ho v hranatých zátvorkách.
Napríklad: 
Abe T. 1978. [Keys to the Japanese fishes fully illustrated in colors. 7th 

revised edition.]. Hokuryukan, Tokyo. 359 pp. (V japončine.) 
Karol HENSELKarol HENSELKarol HENSEL
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